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Chapter 1 - Enhancements

This chapter presents a high-level description of the following enhancements to the Medisoft® 
system. 

In this chapter

Support for ICD-10 Updated Diagnosis Codes
The Centers for Medicare and Medicaid Services (CMS) is adopting a new version of diagnosis 
codes. This new system, ICD-10 (International Classification of Diseases, 10th revision) will 
provide more diagnosis codes for expanded, more detailed coding and billing. 

Format for ICD-10 Codes
The format for ICD-10 codes consists of seven characters with the following format: xxx.xxxx. It has 
the following properties:

 • Alpha or numeric characters

 • The first character is always alphabetic and is not case-sensitive

 • All letters except U are used

 • Characters two through seven can be alphabetic or numeric.

 • Alphabetic characters are not case sensitive.

Mapping ICD-10 Codes to ICD-9 Codes
There is no straight one-to-one mapping from either ICD-9 to ICD-10 or vice-versa for ALL codes. 
However, approximately 88% of all ICD-10 codes have an exact or approximate matching ICD-9 
code. CMS has provided General Equivalency Mappings to help you with the process. For the 
remainder of the codes, ICD-10 codes can be mapped to more than one ICD-9 code, and for a 
very small percentage there is no ICD-9 equivalent. 

Topic See page

Support for ICD-10 Updated Diagnosis Codes 1

Revised CMS-1500 Claim Form 24

Revised Selections for Race and Ethnicity 31

Mediutils 33

Updated Version of Advantage Database Server 33
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Setting up Medisoft 19 for the New Diagnosis Codes Chapter 1 - Enhancements

Setting up Medisoft 19 for the New Diagnosis Codes

Prior to Installation of Medisoft 19 for Upgraders
Prior to installing Medisoft 19, print the Diagnosis Code grid as a reference for your existing 
diagnosis codes. 

If your setup was non-standard, you may need to re-enter some codes after conversion.

During Conversion to Medisoft 19
When Medisoft 19 is installed, the following will take place automatically:

 • If the ICD-9 field (formerly the Code 2 field) was empty, all values in the old Code 1 field will be 
copied to the ICD-9 field. If the ICD-9 field was populated, no change will be made. 

 • If the value in the old Code 1 field is copied, the description of the field will be copied into the 
Description field for the new ICD-9 field.

 • The ICD-10 field (formerly the Code 3 field) will be cleared. Any codes or other values that had 
been in this field must be re-entered after conversion to Medisoft 19. You can no longer use the 
old Code 3 field (now ICD-10 field) for ICD-9 codes. if your claims use this field, you must 
change them to use the ICD-9 field. 

After Installation of Medisoft 19
Once the installation of Medisoft 19 is complete and your practice data has been converted, you 
can use the ICD-10 Code Mapping Utility to create ICD-10 equivalents for existing ICD-9 codes. 
For more information, see “Create ICD-10 Mappings Utility” on page 15. Where there is no direct 
correlation of an ICD-10 code to an ICD-9 code, you can make a choice based on your practice 
needs. 

In addition, there is a new utility that quickly allows you to specify which code set (ICD-9 or ICD-10) 
your insurance carriers will be using. See “Setting ICD Version Utility” on page 13 for more 
information. 

If you have created custom labels for the old Code 1, 2, or 3 fields, you will need to recreate them.

After Installation--Electronic Claims for Upgraders
With Medisoft 19, you can no longer use Code 1 on the Diagnosis Entry screen for electronic 
claims, since this value is not specific to a version of the ICD code set. Instead, you must use the 
new Set ICD Version utility to set all of your carriers to use ICD-9. For more information on this 
screen, see “Setting ICD Version Utility” on page 13.

After Installation--Paper Claims for Upgraders
If you had a customized insurance claim and it is possible that you set the claim to look at Code 1 
or Code 3 (on the Diagnosis Entry screen) for box 21, you must change it to use the Code 2 field 
(now the ICD-9 field) when using the current CMS-1500 form.

Note: the table name in the report designer shows ICD-9.

The new claim is already set to use the ICD-9 or ICD-10 fields. The new claim cannot use the Code 
field on the Diagnosis Entry screen. 
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Chapter 1 - Enhancements Diagnosis List screen

Diagnosis List screen

New and Renamed Columns
There are several new and renamed columns on the Diagnosis List screen.

Note: customized column headers for the Code, Code 1, and Code 2 will be overwritten during 
conversion.

Figure 1.  Diagnosis List screen

New Check Boxes
In addition, there are three new check boxes:

Name in Earlier 
Releases

Name in Medisoft 19 Description of Updated Column

Code 1 Code This field remains the same as in earlier 
releases.

Code 2 ICD-9 This field displays the ICD-9 associated 
with the Code field.

ICD-9 Description This field displays the description of the 
ICD-9 code. 

Code 3 ICD-10 This field displays the ICD-10 code 
associated with the Code field.

ICD-10 Description This field displays the description of the 
ICD-10 code. 

Check Box Description

Partial Match Select this check box if you want Medisoft to search for a partial 
match on an item. 

Display ICD-9 Codes Select this check box if you want to see ICD-9 codes in the list. This 
includes all codes that have a value in the ICD-9 Code field on the 
Diagnosis Entry screen. The default value is selected.
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Diagnosis Screen Chapter 1 - Enhancements

Selecting both of these check boxes will show all codes that have values in either the ICD-9 or 
ICD-10 Code fields. Selecting neither check box will show codes for which the ICD-9 and ICD-10 
Code fields are empty. These are codes that have a value only in the Code field.

Updated Field
The Field field has new selections for filtering this list. Previously, you could filter only by Code 1 
and Description.

You can now filter by

 • Code

 • Description

 • ICD-9

 • ICD-9 Description

 • ICD-10

 • ICD-10 Description

Diagnosis Screen

New and Renamed Fields
The Diagnosis screen has several new fields and changes to field names:

Display ICD-10 Codes Select this check box if you want to see ICD-10 codes in the list. 
This includes all codes that have a value in the ICD-10 field on the 
Diagnosis Entry screen. The default value is selected.

Check Box Description

Name in Earlier 
Releases

Name in Medisoft 19 Description of Updated Field

Code 1 Code This field remains the same as in earlier 
releases.

Code 2 ICD-9 This field displays the ICD-9 associated 
with the Code field.

ICD-9 Description Use this to enter a description of the ICD-
9 code. You can enter up to 50characters. 

Code 3 ICD-10 This field displays the ICD-10 code 
associated with the Code field.

ICD-10 Description Use this to enter a description of the ICD-
10 code. You can enter up to 50 
characters. 
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Chapter 1 - Enhancements Program Options HIPAA/ICD 10 tab

NOTE: Many of the reports in Medisoft will still display options for the old code names. These field 
names were not changed in the data table. 

Figure 2.  Diagnosis screen

New Buttons
There are two new Copy buttons on the Diagnosis screen. Click a button to copy the Code and 
Description at the top of the screen into the corresponding ICD-9/ICD-10 and Description fields. 

Figure 3.  Diagnosis screen with Copy button highlighted

Program Options HIPAA/ICD 10 tab
The HIPAA tab in Program Options has been renamed to HIPAA/ICD 10. In addition, there is a new 
field for specifying the default code sets (ICD-9 or ICD-10) for new diagnosis codes. This new field 
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Insurance Carriers - Options and Codes tab Chapter 1 - Enhancements

is for users of Medisoft Clinical who will upgrade to the future release Medisoft Clinical 19 Service 
Pack 1 with Practice Partner 11. 

Figure 4.  Program Options - HIPAA/ICD 10 tab

Insurance Carriers - Options and Codes tab

Updated Field
The Diagnosis Code Set field drop-down selections now include ICD-9 and ICD-10. The selection 
here will determine the default code set used for this insurance carrier. 

New Field
There is a new field on the Options and Codes tab of the Insurance Carriers screen: ICD-10 
Effective Date. Use this field to enter a date of service that will be the effective start date for using 
ICD-10 codes on claims. This field will allow you to continue to use ICD-9 codes for claims that are 
submitted prior to the effective date or claims that need to be rebilled after the effective date. 

This field will be disabled if you select ICD-9 in the Diagnosis Code Set field. If a date had been 
entered in the ICD-10 Effective Date field and you change the value in the Diagnosis Code Set field 
to ICD-9, the date will be cleared and the field disabled. 
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Chapter 1 - Enhancements Insurance Carriers List Screen

Figure 5.  Insurance Carriers screen - Options and Codes tab

You can quickly set the default Diagnosis Code Set and Effective Dates for all your insurance 
carriers using the Set ICD Version utility. For more information, see “Setting ICD Version Utility” on 
page 13.

Insurance Carriers List Screen
There are two new columns for the Diagnosis Code Set and ICD-10 Effective Date. You can add or 
remove these columns using the Grid Columns screen.

Transaction Entry

New Error Indicator
If you enter or select a diagnosis code that does not have a value in the code set of the primary 
insurance carrier, the field will turn red to indicate the error.

Only the primary insurance carrier is checked on this screen.
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New Warning Message Chapter 1 - Enhancements

Figure 6.  Transaction Entry screen with highlighted error indicator

New Warning Message
When you save a transaction, Medisoft will check for the codes in the Diagnosis fields against the 
default diagnosis code set specified on the Options and Codes tab on the primary Insurance 
Carrier screen (see “Insurance Carriers - Options and Codes tab” on page 6). If a diagnosis code 
used does not have a value (code) for the code set used by the carrier, you will receive a warning 
message. If the code set for the primary carrier is ICD-9 and one of the diagnosis codes entered 
does not have an ICD-9 filled in, you will receive a warning message. Similarly, if the code set for 
the primary carrier is ICD-10 and one of the diagnosis codes entered does not contain an ICD-10 
code, you will receive a warning message.

Figure 7.  Diagnosis Code Set Warning message

If you select Yes, Medisoft will save the transaction as it has been entered. If you select No, 
Medisoft will display the Transaction Entry screen so that you can change the diagnosis code. 
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Chapter 1 - Enhancements Updated Claim Status menu

Updated Claim Status menu
This shows the claim has a status of Dx Error. If the warnings in Transaction Entry were not fixed 
and claims were created, they will have the status of Dx Error. You can use this drop-down to 
change the status. 

Figure 8.  Transaction Entry screen with drop-down for Change Claim Status displayed

New Right-Click Option
When the pointer is in a Diagnosis Code field, right-clicking will open the Search Diagnosis screen.

Unprocessed Charges

New Error Indicator
There is a new error indicator on the Unprocessed Charges screen. If a clinical system sends a 
charge with a diagnosis code that does not have a value (code) for the code set for the primary 
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Unprocessed Charges Chapter 1 - Enhancements

carrier, the field will turn red to indicate the error. You will not be able to post the transaction until 
the issue is resolved.

Figure 9.  Unprocessed Charges screen with error indicator highlighted

New Keyboard Shortcut
When the pointer is in a Diagnosis Code field, pressing F6 will open the Search Diagnosis List 
screen.

New Error Indicator
There is a new error indicator on the Unprocessed Charges Edit screen. If a clinical system sends 
a charge with a diagnosis code that does not have a value (code) for the code set for the primary 
carrier, the field will turn red to indicate the error. 

Figure 10.  Unprocessed Transactions Edit screen with error indicator highlighted

In addition, the error will display in the upper right of the screen.
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Chapter 1 - Enhancements Claim Management

New Right-Click Option
When the pointer is in a Diagnosis Code field, right-clicking will open the Search Diagnosis List 
screen.

Claim Management
There is a new Status for claims: DX Error. You will see this status if a diagnosis code used does 
not have a value (code) for the code set used by the carrier. For example, you will see this status if 
the insurance carrier is set for ICD-10 codes but the diagnosis code entered for the transaction on 
the claim only has an ICD-9 code in the Diagnosis Entry screen.

Figure 11.  Claim Management List screen with DX Error shown

New option
There is a new option, Dx Error, available in the list of Claim Statuses on the Carrier 1, Carrier 2, 
and Carrier 3 tabs.
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Claim Management Chapter 1 - Enhancements

Figure 12.  Claim screen with new Claim Status option highlighted

New Error Indicator
If a claim is created with a diagnosis code that does not have a value (code) for the code set used 
by the primary carrier, the field will turn red to indicate the error on the Transactions tab of the 
Claims screen. The color indicator will first show claims for the primary carrier. When the primary 
carrier is billed, then it will show the status of codes for the secondary carrier. If there is a tertiary 
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carrier, the color indicator will show the status of the codes only after both primary and secondary 
carriers have been billed. 

Figure 13.  Claim screen - Transactions tab with error indicator highlighted

With Medicare crossover claims, the secondary insurance that is crossed over will receive a Bill 
Date at the same time that the Medicare claim is printed/sent. In this situation, the red Diagnosis 
error will be validated only for the Primary Medicare.  

Setting ICD Version Utility
There is a new utility that you can use to specify which diagnosis code set each insurance carrier 
will use. 
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Setting ICD Version Utility Chapter 1 - Enhancements

New Menu Option
On the Tools menu under Services, there is a new option called Set ICD Version. Click this to 
open the Set ICD Version utility. You can open this screen by pressing the S key from this menu. 

Figure 14.  Tools menu

New Utility
The Set ICD Version utility will show all existing insurance carriers and the current default 
diagnosis code set for each one. Select which carriers you want to change to ICD-10. 

When you are ready, click the Update Selected button to update your settings. You can run this 
utility as many times as you want.

Figure 15.  Set ICD Version screen

Field/Button/Check Box Description

Code Set Select this check box if you want to make changes for the 
Code Set for the selected carriers.
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Chapter 1 - Enhancements Create ICD-10 Mappings Utility

You cannot change the code set for an insurance carrier whose record is open for edit in the 
Insurance Carriers screen. You must close the record first. 

Create ICD-10 Mappings Utility
There is a new Create ICD-10 Mappings utility. 

Have only ONE user at a time updating and creating codes. 

Update the default code set 
for claims to 

Select which code set you want to use to update the selected 
carriers.

ICD 10 Effective Date

Use the ICD-9 code set for 
claims with a date of service 
prior to: 

Select this check box if you want to make changes to the ICD-
10 Effective Date for the selected carriers.

Enter the effective date you want to use for the selected 
carriers. This date marks the day on which this carrier will stop 
using ICD-9 codes on claims. 

When the code set is ICD-10, claims with a date of service 
prior to this date will continue to use ICD-9 codes.

These fields will be disabled if the value in the Update the 
default code set for claims to field is set to ICD-9. If there was 
a date in the field, it will be cleared and the field will be 
disabled.

Code This field shows the Insurance Carrier Code.

Name This field shows the Insurance Carrier Name.

Type This field shows the type for the insurance carrier.

Code Set Shows the current default Diagnosis Code Set for the carrier.

ICD 10 Effective Date This field shows the date that ICD-10 codes will be used for 
the carrier. 

This field will be cleared and disabled if you change the code 
set for the carrier to ICD-9.

Select/De-select All Use this button to select or clear the check boxes for all 
carriers, those next to the Code field in the grid.

Update Selected Use this to run the utility after you have made your selections. 
Depending on your selections, all carriers with the check box 
selected next to their Code name will have their Code Set and/
or Effective dates updated to your selections.

Close Use this to close the screen without making any changes.

Field/Button/Check Box Description
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New Menu Item
To access this screen, on the Tools menu, point to Services, and click Icd-10 Mapping Utility.

Figure 16.  Tools menu with Icd-10 Code Mapping Utility option highlighted

You can also open this screen by pressing the C key from this menu. 

New Screen
Use Create ICD-10 Mappings Utility to automatically create new ICD-10 codes that are mapped to 
existing ICD-9 codes or update an existing ICD-10 code with an ICD-9 already in your list. The 1:1 
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Chapter 1 - Enhancements Create ICD-10 Mappings Utility

Mappings tab will show you the codes that can be mapped automatically. Select those codes you 
want and click Create Selected Codes. 

Figure 17.  Create ICD-10 Codes - 1:1 Mappings tab

A  icon on a line item indicates that the ICD-10 code already exists in your list of diagnosis 
codes but it has not been mapped to an ICD-9 code. When you select the check box for this code, 
Medisoft will enter your ICD-9 code into the existing code in the table.

You can also change the code value listed in the New Code column by clicking in the field. In this 
way, you can customize a new code according to your needs. 

The table below shows the fields and buttons on this screen with a description of each.

Element Description

Grid The box shows you the ICD-9 codes and their 
corresponding mappings.
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Create ICD-10 Mappings Utility Chapter 1 - Enhancements

New Code Select the check box to view the new code that 
will be created. If you want to change it, click in the 
column and enter your own code. If the new ICD-
10 code already exists, you will receive a warning. 
You cannot have duplicate codes. 

In some cases, Medisoft will add a letter to the end 
of the new ICD-10 code. This will happen if there 
are several ICD-9 codes that can be directly 
mapped to a single ICD-10 code. Since you 
cannot map several codes to a single code, 
Medisoft will append a letter to create unique ICD-
10 codes for each ICD-9 code. See Figure 17 on 
page 17.

Note: the code with an appended letter is never 
used on claim forms. Claim forms will use the 
code in the ICD-9 or ICD-10 field, depending on 
the insurance carrier’s code set. 

Your Code This column shows the code of the existing code, 
usually the ICD-9 code, if you have not entered 
any ICD-10 codes. This value comes from the 
Code field on the Diagnosis screen.

Your Description This column shows the description of the existing 
code. The description here comes from the 
Description field associated with the Code field on 
the Diagnosis screen.

ICD-9 Code This column shows you the ICD-9 code.

ICD-9 Description This column shows you the ICD-9 description.

ICD-10 Code This column shows you the ICD-10 code.

ICD-10 Description This column shows you the ICD-10 code’s 
description.

Select/De-Select All Click this button if you want select or clear all 
codes in the box.

Create Selected Codes Click this button when you are ready to create the 
ICD-10 codes.

Cancel Click this button to cancel all changes.

Element Description
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The Other Mappings tab shows you ICD-9 codes that have multiple mappings. Select the ones that 
apply to your practice and click Create Selected Codes.

Figure 18.  Create ICD-10 Codes - Other Mappings tab

Element Description

Top Grid The box shows you the existing ICD-9 codes. 
Click a line item to see possible matches in the 
bottom grid.

Your Code This column shows the code of the existing Code 
in your diagnosis list. This value comes from the 
Code field on the Diagnosis screen.

Your Description This column shows the description of the existing 
code. The description here comes from the 
Description field associated with the Code field on 
the Diagnosis screen.

ICD-9 Code This column shows you the ICD-9 code.

ICD-9 Description This column shows you the ICD-9 description.

Bottom Grid This section of the screen shows you the possible 
ICD-10 matches for the highlighted item in the top 
grid. 
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New Code Select the check box to view the new code that 
will be created. If you want to change it, click in the 
column and enter your own code. If the new ICD-
10 code already exists, you will receive a warning. 
You cannot have duplicate codes. 

In some cases, Medisoft will add a letter to the end 
of the new ICD-10 code. This will happen if there 
are several ICD-9 codes that can be directly 
mapped to a single ICD-10 code. Since you 
cannot map several codes to a single code, 
Medisoft will append a letter to create unique ICD-
10 codes for each ICD-9 code.

Note: the code with an appended letter is never 
used on claim forms. Claim forms will use the 
code in the ICD-9 or ICD-10 field, depending on 
the insurance carrier’s code set. 

When you select the check box, Medisoft will 
auto check all options below it. You can clear 
items below the master item, as long as one item 
below is selected. The top check box will remain 
selected. If you clear the top check box, then all 
selections below are cleared as well. If you 
manually clear all the check boxes below, the top 
check box remains cleared. If you use Select/
Deselect All, the top check box will be selected or 
cleared depending on the state. 

ICD-10 Code This column shows you the ICD-10 that is a 
possible match.

Standard ICD-10 Long Description This column shows you the long description for 
the ICD-10 code.

The short description is not shown but is 
displayed on the Diagnosis Entry screen. The 
long form appears here to help you with making 
decisions about which codes to map. 

ICD-9 Code This column shows you the existing ICD-9 Code 
that would be matched to the ICD-10 code.

Standard ICD-9 Long Description This column shows you the existing description for 
the ICD-9 code that would be matched to the ICD-
10 Code.

Select/De-Select All Click this button if you want select or clear all 
codes in the box.

Create Selected Codes Click this button when you are ready to create the 
ICD-10 codes.

Element Description
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UB Paper Claims
There are two new UB04 claims forms: UB04 (Primary) - v19 W/Form and UB04 (Primary) - v19. 
These are provided to allow printing of the longer ICD-10 diagnosis codes, as well as the ICD-9 or 
ICD-10 (0) qualifier. The application now checks to see what code set the insurance carrier uses 
and prints the ICD-9 or ICD-10 code that corresponds to the code 1 value stored in the table.  

Figure 19.  Open Report screen with new UB04 Claim Forms highlighted

Reports
To accommodate ICD-10, the following reports were updated:

Cancel Click this button to cancel all changes.

Element Description

Report Modification

Export Diagnosis Data It now displays all 12 diagnosis code fields.

Diagnoses Ranking (Case Count) The field length on the form was updated 
so an ICD-10 code will fit.

Diagnoses Ranking (Charge Count) The field length on the form was updated 
so an ICD-10 code will fit.

Diagnosis List The report has been reformatted and will 
display the new description fields for 
codes.
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Print Diagnosis Grid The report has been reformatted and will 
display the new description fields for 
codes.

Patient Face Sheet The face sheet has been updated to print 
either ICD-9 or ICD-10 codes based on the 
values selected for the code set for the 
insurance carrier. 

The report will compare the date that the 
case was created with the Effective Date 
for the insurance carrier and print ICD-9 
codes if the case created date was before 
the Effective Date, and ICD-10 codes if the 
case created date was on or after the 
Effective Date for the carrier. 

If a diagnosis code used does not have a 
value (code) for the code set used by the 
carrier, you will receive a warning message 
when you attempt to print the face sheet. 
For example, if the code set for the carrier 
is ICD-9 and one of the diagnosis codes 
entered does not have an ICD-9 value 
filled in, you will receive a warning 
message. 

In addition, for cash cases the face sheet 
will display ICD-9 codes for dates prior to 
October 1, 2014 and ICD-10 codes for 
dates on or after October 1, 2014. 

Report Modification
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Medisoft Reports
There are new Medisoft Reports.

Diagnosis Ranking (Charge count)
There are three new Diagnosis Ranking (Charge count) reports:

 • Primary Diagnosis Ranking by Code (charge count)--This report takes values from the Code 1 
field of the Diagnosis screen.

 • Primary Diagnosis Ranking by ICD 9 (charge count) --This report takes values from the ICD-9 
field of the Diagnosis screen.

 • Primary Diagnosis Ranking by ICD 10 (charge count) --this report takes values from the ICD-
10 field of the Diagnosis screen.

Walkout Receipts The Walkout receipts will now print ICD-10 
codes. 

These receipts will display the diagnosis 
codes for the primary insurance carrier. If a 
diagnosis code used does not have a 
value (code) for the code set used by the 
carrier, you will receive a warning message 
when you attempt to print the receipt. For 
example, if the code set for the primary 
carrier is ICD-9 and one of the diagnosis 
codes entered does not have an ICD-9 
value filled in, you will receive a warning 
message. 

Medisoft will also check the Date of 
Service for the receipt and compare it with 
the Effective Date in the insurance carrier’s 
record to determine which code set to use. 
If the Date of Service is before the 
Effective date, the receipt will display ICD-
9 codes; if the Date of Service is on or 
after the Date of Service, the report will 
display ICD-10 codes.

In addition, for cash cases the report will 
display ICD-9 codes for dates prior to 
October 1, 2014 and ICD-10 codes for 
dates on or after October 1, 2014. 

Quick Receipt is unchanged.

Patient List by Primary Diagnosis This report will now print ICD-9 and ICD-10 
codes. Also, it will print in Landscape 
format.

Report Modification
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Diagnosis Ranking (Case count)
There are three new Diagnosis Ranking (Case count) reports:

 • Primary Diagnosis Ranking by Code (case count)--This report takes values from the Code 1 
field of the Diagnosis screen.

 • Primary Diagnosis Ranking by ICD 9 (case count)--This report takes values from the ICD-9 
field of the Diagnosis screen.

 • Primary Diagnosis Ranking by ICD 10 (case count) --This report takes values from the ICD-10 
field of the Diagnosis screen.

Revised CMS-1500 Claim Form
The National Uniform Claim Committee (NUCC) has a revised claim form.
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Important: When this form has been approved for claims submission, you can use this same form 
for Medicare claims as well. You do not need to use a separate form any longer when using the 
new 02/12 form. 

Figure 20.  02/12 CMS-1500 Claim Form
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Timeline
The NUCC has approved a transition timeline for the version 02/12 1500 Health Insurance Claim 
Form (1500 Claim Form). In June, the NUCC announced the approval of the updated 1500 Claim 
Form that accommodates reporting needs for ICD-10 and aligns with requirements in the 
Accredited Standards Committee X12 (ASC X12) Health Care Claim: Professional (837P) Version 
5010 Technical Report Type 3.

The NUCC approved the following transition timeline at its in-person meeting in Chicago on August 
1, 2013.

 • January 6, 2014: Payers begin receiving and processing paper claims submitted on the 
revised 1500 Claim Form (version 02/12).

 • January 6 through March 31, 2014: Dual use period during which payers continue to receive 
and process paper claims submitted on the old 1500 Claim Form (version 08/05).

 • April 1, 2014: Payers receive and process paper claims submitted only on the revised 1500 
Claim Form (version 02/12).

Changes for New Requirements
The following changes have been made for new requirements.

Box Box Description Change on Form

1 Insurance Type Champus was removed and changed to Tricare.

5 Patient’s Address The phone number no longer prints based on the 
NUCC’s (National Uniform Claim Committee) 
suggestion. 

8 Reserved for NUCC use

(Was Patient Status)

This box shows the value of the new Box 8 field on 
the Miscellaneous tab of the Case window.

9b Reserved for NUCC use.

(Was Date of Birth and Sex)

The box shows the value of the new Box 9b field 
on the Miscellaneous tab of the Case window.

9c Reserved for NUCC use. 

(Was Employer or School 
Name)

This box shows the value of the new Box 9c field 
on the Miscellaneous tab of the Case window. 

10d Claim Codes (Designated by 
NUCC)

(Was reserved for local use)

This box will reflect multiple case condition codes 
separated by a space.

11b Other Claim ID (designated 
by NUCC). 

(Was Employer Name) 

This box will show the claim number field from the 
case Policy tab, preceded by a Y4 qualifier.
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14 Date Current Illness Injury or 
LMP

In addition to the date, there is a new Qualifier 
Code:

431 - Illness (selected when the Illness Indicator 
field is set to Illness)
484 - LMP (selected when the Illness Indicator field 
is set to LMP)

15 Other Date In addition to the date (selected based on which 
date field is completed in the order below), there is 
a new Qualifier Code:

454 - Initial Treatment
304 - Latest Visit/Consultation
453 - Acute Manifestation of a Chronic 
Condition
439 - Accident
455 - Last X-Ray
471 - Prescription
090 - Report Start
091 - Report End

17 Referring Provider This box can be used for various physician types. 
There are new qualifiers indicating the physician’s 
type:

DN - Referring Provider 
DK - Ordering Provider 
DQ - Supervising Provider

Only one can be used. If more than one exists on 
the case, the system will use the following order: 1. 
referring, 2. ordering, 3. supervising.  

If both supervising and referring exist on the case, 
Medisoft will print the referring provider.

If the Send Ordering Provider in Loop 2420E check 
box on the destination payer’s Insurance record 
(EDI-Eligibility tab) is selected and there is a 
referring physician, DK (Ordering Provider) instead 
of DN will print.

17a Other ID This box shows the ID of the provider from Box 17

17B NPI Number This box shows the NPI number of the provider 
from Box 17.

21 Diagnosis Codes Diagnosis codes 5-12 (indicated as E-L) have 
been added. Diagnosis codes are listed in order 
from left to right on three lines with four codes per 
line. In addition, there is an ICD Code Set 
Indicator: 

9 - ICD-9

0 - ICD-10

Box Box Description Change on Form
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Other Changes 
The following are other changes made to the data that prints on the form.

24e Diagnosis Pointer This box was changed to alpha characters (A-L).

30 Reserved for NUCC use. This box used to show the balance due. 

Box Box Description Change on Form

Box Box Description Change on Form

2 Patient’s Name The NUCC suggests not printing the patient’s 
name but, when the patient is the subscriber, the 
patient’s name will continue to print on the form. 

4 Insured Name This box now includes functionality for worker’s 
compensation. If the Insurance Type of the 
destination payer is worker's compensation, the 
patient case employer name will print.

7 Employer Address This box now includes functionality for worker’s 
compensation. If the Insurance Type of the 
destination payer is worker's compensation, the 
patient case employer address will print.

11 Insured's policy group or 
FECA number 

If the primary insurance is Medicare, NONE will 
print in this box. 

Otherwise, Medisoft will print the insured's policy 
group or FECA number This information comes 
from the Case window, Policy 1, 2, or 3 tab, Group 
Number field.

11c Insured's insurance plan 
name or program name

If Medicare is the secondary insurance, this box 
will remain blank.

Otherwise, Medisoft will print the insured's 
insurance plan name or program name. This 
information comes from the Insurance Carrier 
window, Address tab, Plan Name field. If there is 
no name in the Plan Name field, the insurance 
carrier name prints in this box.

11d Is there another health 
benefit plan?

If the primary insurance is Medicare, this box will 
remain blank.

Otherwise, if there is a value in the Insurance field 
of the Policy 1 or 2 tab in Cases, the Yes check box 
is selected. If that value is empty, the No check box 
is selected.
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19 Additional Claim 
Information (designated by 
NUCC)

(Was reserved for local use)

If there is a Taxonomy Code in the Provider ID grid 
for the provider in Box 24j, Medisoft will use that 
information first for Box 19.  The qualifier ZZ 
followed by the taxonomy value will print.  For 
example, ZZ163WG0100X. 

If there is a value in the Legacy Identifier 2 field for 
that provider, the Legacy Identifier 2 qualifier and 
value will print.  For example, 0B98765466.

If the Payer type is Worker's Comp, three blank 
spaces and the Transaction Entry EDI notes for 
PWK, in addition to the IDs listed above, will print. 

If none of these conditions are met, Medisoft will 
print the value in the Local Use B field on the Case 
- Miscellaneous tab.

23 Prior Authorization Number If there is no Prior Authorization Number, the Claim 
Facility CLIA Number will print. 

24h EPSDT Unshaded area: A Y will print if the EPSDT check 
box on the Case window - Medicaid-Tricare tab is 
selected, unless Code 1 of the EPSDT Referral 
Codes is populated. In that case, the code will be 
printed instead of Y.

Shaded area: if the EPSDT check box is selected 
and the Family Planning check box is selected, Y 
will be printed. If EPSDT is selected and Family 
planning is not, N will be printed. 

24 
shaded

Transaction Description Shaded area: If an NDC code is used, N4 will be 
printed and then the transaction NDC Code, a 
single space, followed by the NDC Unit of 
Measurement and NDC Unit Count. If you have 
entered text in the description field for a 
transaction, ZZ followed by the transaction 
description will print. If both are used, the NDC 
information prints first.

29 Amount Paid This field is left blank. On secondary claims, it will 
show the calculated amount paid by the primary 
insurance carrier. 

Box Box Description Change on Form
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Case Screen

New Fields
There are four new fields on the Miscellaneous tab of the Case screen in the CMS-1500 Reserved 
for NUCC section. If necessary, you can use these fields for populating the boxes on the 02/12 
CMS-1500 claim form.

Figure 21.  Case screen - Miscellaneous tab with new fields highlighted
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Reports
There are six new claim forms available in Medisoft Reports Designer: CMS-1500 (Primary)- 2012 
W/Form, CMS-1500 (Primary)-2012, CMS-1500 (Secondary)-2012 W/Form, CMS-1500 
(Secondary) -2012, CMS-1500 (Tertiary) - 2012 W/Form, and CMS-1500 (Tertiary)-2012. 

Figure 22.  Open Reports screen with new CMS-1500 Claim Forms highlighted

Revised Selections for Race and Ethnicity
The selections for the Race and Ethnicity fields now accommodate Meaningful Use Stage 2. 

Race
The selections for the Race field on the Patient/Guarantor screen - Name, Address tab have been 
updated. In addition, the application has been updated to allow you to select up to two values for 
the Race field. The following table shows the changes:

Prior to Medisoft 19 Medisoft 19 and above

American Indian or Alaskan Native American Indian or Alaska Native (I)

Black Black or African American (B)

Caucasian White (W)

Pacific Islander Native Hawaiian or Other Pacific Islander 
(P)
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Ethnicity
The selections for the Ethnicity field on the Patient/Guarantor screen - Name, Address tab screen 
have been updated. The following table shows the changes: 

Figure 23.  Patient/Guarantor screen - Name, Address tab

Prior to Medisoft 19 Medisoft 19 and above

Hispanic Hispanic or Latino

Non-Hispanic Not Hispanic or Latino
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NOTE: if you have included Race in any Patient Quick Entry templates, you must edit the template 
and click the Reset button on the Patient Entry Template screen. If you do not do this, you may 
receive an error. 

Mediutils
Some changes have been made to the Mediutils features.

Copy Data Tables
The following fields have been added to the table. 

 • MWDIA        [Code Version], [Code 2 Description], [Code 3 Description]

 • MWINS        [Icd 10 Effective Date] 

This is the Effective Date field in Medisoft.

 • MWOPT       [DefInsCodeSet]

 • MWOPT       [DefDiagCodeSet]

Power Tools

Code Fix tab
The Code 1, 2, and 3 tabs have been changed to Code, ICD-9, and ICD-10.

Figure 24.  Power Tools - Code Fix tab

Updated Version of Advantage Database Server
Medisoft 19 includes Advantage 11.10 as its database manager. 
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If you are installing or upgrading Medisoft Network Professional or Medisoft Clinical, you must 
install this new version of Advantage. Install it on your server computer following the instructions in 
the Medisoft Installation Guides. 

The Remote Management Utility, located under Advantage Tools on the Install screen, is a 16 bit 
utility and will not install in a 64 bit environment. 

Medisoft 19 and Practice Partner 9.5.2 (Medisoft Clinical)
Since Medisoft 19 is ICD-10 ready and Practice Partner 9.5.2 is not ICD-10 ready, McKesson 
recommends that you do not send ICD-10 diagnosis codes from Medisoft 19 to Practice Partner 
9.5.2. 

If you send charges from Practice Partner to Medisoft with diagnosis codes that do not exist in 
Medisoft, they will appear on the Unprocessed Charges screen in red and you must add the codes 
in Medisoft before you can post the charges. Previously, these codes would appear in yellow and 
they could be posted. 

In addition, Medisoft 19 will transmit two values for Race to Practice Partner. However, Practice 
Partner will only use the first one. McKesson recommends that you currently select only one value 
in the Race field. 

If you are already using a version of Medisoft Clinical that has Practice Partner 9.5.2, do not install 
Medisoft Clinical Server on your server, and do not install Medisoft Clinical Client on your 
workstations. You only need to upgrade Medisoft Client. 

McKesson Practice Interface Center (MPIC)
McKesson Practice Interface Center, which replaces Communications Manager, is an application 
designed to connect different McKesson solutions and allow them to transfer data to one another. It 
is independent of Medisoft, but has prefabricated configurations available to integrate Medisoft with 
Practice Partner (Medisoft Clinical), Practice Choice, and RelayHealth. You will also have the ability 
to customize it.

Communications Manager is not available for Version 19 of Medisoft.  If you were using 
Communications Manager with a  previous version of Medisoft, please contact your VAR for 
assistance before upgrading to Version 19.
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The following issues were resolved with Medisoft Release 19. 

TD Application Description

22685 Core You can now save allowed amounts for procedure codes that do 
not have modifiers. Previously, allowed amounts would 
disappear when you edited procedure codes because they 
were not being saved.

Steps to recreate

1. On the Lists menu, select Procedure/Payment/
Adjustment codes. The Procedure/Payment/Adjustment 
List screen appears.

2. Double-click a procedure code. The Procedure/Payment/
Adjustment screen appears.

3. Add a modifier in the Default Modifiers field.

4. Select the Allowed Amounts tab.

5. Enter an amount for an insurance carrier.

6. Click Save. The Procedure/Payment/Adjustment screen 
appears.

7. Double-click the same procedure code.

8. Click the Allowed Amounts tab.

9. Verify that the amount you entered is present.

23158 Office Hours 
Standalone version

Users will no longer receive the error “QryInCollections:Error 
7200...” when entering an alphabetic character in the Case field 
of the Edit Appointment screen. Previously, this error would 
appear if a user attempted to do this.

Steps to recreate

1. Open Office Hours.

2. Highlight an appointment and right-click in the field and 
select Edit. The Edit Appointment screen appears.

3. Place the cursor in the Case field and attempt to enter an 
alphabetic character.

4. Verify that there is no error.
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23187 Core Users will no longer receive the message “patient record is in 
user” in Unprocessed EMR Charges after another user has 
closed the screen.

Steps to recreate

1. Have user A log into Medisoft.

2. On the Activities menu, point to Unprocessed Transactions, 
and click Unprocessed EMR Charges. The Unprocessed 
Charges screen appears.

3. Select a transaction and click the Edit button. The 
Unprocessed Transactions Edit screen appears.

4. Close this screen.

5. Have User B log into Medisoft. 

6. Repeat steps 2 and 3 and verify that user B does not 
receive the message. 

23274 Communications 
Manager

Communications Manager has been removed from Medisoft 19 
and is being replaced by McKesson Practice Interface Center. 

In addition, the ePrescribing feature has been removed from 
Medisoft 19. 

Steps to recreate

1. In Medisoft, click the Tools menu. The drop-down list 
appears.

2. Verify that Communications Manager is no longer listed as 
an option.

3. On the Tools menu, point to Services. The drop-down list 
appears.

4. Verify that ePrescribing is no longer listed.
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23321 Core Repeating appointments are now skipping days/weeks/months 
correctly. Previously, if users added a weekly recurring 
appointment and had it every three weeks, Medisoft would 
insert an appointment for the current week, another one for the 
next week and then skip one week, and finally insert another 
appointment and follow that order until the end date.

Steps to recreate

1. On the Activities menu, select Appointment Book. The 
Appointment grid appears.

2. On the cell where you want the first appointment to be 
scheduled, right-click and select New Appointment. The 
New Appointment Entry screen appears. 

3. Complete the fields on the screen and click the Change 
button. The Repeat Change screen appears.

4. Enter 3 in the Every ____ Weeks field.

5. Select Weekly for the frequency.

6. Select a day of the week for the appointment.

7. Enter an End Date.

8. Click the OK button. 

9. Click the Save button on the New Appointment Entry 
screen. The appointment appears in the grid. 

10. Verify that the appointment is scheduled once every three 
weeks at the same time and day. 



Release Notes
38 Release 19 November 2013

Chapter 2 - Resolved Issues

23470 Core Users will no longer receive a warning message about an open 
report when closing Transaction Entry or Medisoft. 

Steps to recreate

1. On the toolbar, click the Quick Ledger icon. The Quick 
Ledger screen appears.

2. Select a patient.

3. Click Statement. The Create Statements screen appears.

4. Select Standard and click the Create button.

5. Click OK on the message that appears that a statement 
has been created. The Print Statement screen appears.

6. Click the Cancel button.

7. Close the Quick Ledger screen.

8. On the Activities menu, select Enter Transactions. The 
Transaction Entry screen appears.

9. Select the same patient.

10. Click on Print Receipt. The Open Report screen appears.

11. Select an option and click OK. The Print Report Where? 
screen appears.

12. Select Preview the report on the screen and click the Start 
button.

13. Enter the date range to create the walkout receipt.

14. Click OK.

15. Once the walkout receipt appears, close it.

16. Close the Transaction Entry screen. 

17. Verify that it closes without any warning messaage.
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23245 Core The Document number is now being assigned to posted 
unprocessed transactions. Previously, if the user had the check 
box to Force Document Number selected in Program Options 
and changed the case number for an unprocessed transaction, 
the transaction would save with no document number.

Steps to recreate

1. On the File menu, click Program Options. The Program 
Options screen appears.

2. Select the Data Entry tab.

3. Make sure that the Force Document Number check box is 
selected.

4. Click Save.

5. On the Activities menu, point to Unprocessed Transactions, 
and click Unprocessed EMR Charges. The Unprocessed 
Charges screen appears.

6. Highlight a transaction and click Edit. The Unprocessed 
Charges Edit screen appears.

7. Change the case for the transaction. 

8. Verify the transaction has a document number and click 
Post. 

9. Close the Unprocessed Charges screen. 

10. On the Activities menu, click Transaction Entry.

11. Select the patient for whom the unprocessed transactions 
were posted.

12. Select the case. 

13. Click the icon at the right of the Document field and verify 
that the document number was saved.

23705 Core The Patient Entry screen will now keep its sizing when the 
screen is closed and reopened. Previously, any changes to the 
size of the screen would not persist.

Steps to recreate

1. On the Lists menu, Select Patients/Guarantors and Cases. 
The Patient List screen appears.

2. Click the New Patient button. The Patient screen appears. 

3. Enter data for a new patient and resize the screen.

4. Click the Save button.

5. Close the Patient screen.

6. Click the New or Edit button and verify that the screen 
appears with the new dimensions. 



Release Notes
40 Release 19 November 2013

Chapter 2 - Resolved Issues


	Title page
	Table of contents
	List of Figures
	Chapter 1 - Enhancements
	Support for ICD-10 Updated Diagnosis Codes
	Revised CMS-1500 Claim Form
	Revised Selections for Race and Ethnicity
	Mediutils
	Updated Version of Advantage Database Server
	Medisoft 19 and Practice Partner 9.5.2 (Medisoft Clinical)
	McKesson Practice Interface Center (MPIC)

	Chapter 2 - Resolved Issues

